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About the Book
At a Glance

Document Scope

The Quick Start Guide uses an application example to describe the different steps to quickly install, 

configure, and control TeSys U motor starters. With this Quick Start Guide, you can easily set up a 

DeviceNet communication network, provided that you have a basic knowledge in Allen-Bradley PLCs and 

Rockwell Automation application software (RSNetWorx for DeviceNet and RSLogix 5000). Allen-Bradley 

is a trademark of Rockwell Automation. RSLinx, RSNetworx, and RSLogix are trademarks of Rockwell 

Software. 

You do not need any other document to perform this task.

For more details about other capabilities of TeSys U motor starters, consult the related documents listed 

below.

Validity Note

The information described in this Quick Start Guide is valid for the hardware and software used in the 

application example provided. The same procedures can be used with different versions of the hardware 

and software given provided that compatible versions are used.

Related Documents

You can download these technical publications and other technical information from our website at 

www.schneider-electric.com.

User Comments

We welcome your comments about this document. You can reach us by e-mail at techcomm@schneider-

electric.com.

Title of Documentation Reference Number

TeSys U LULC09 DeviceNet Communication Module - User’s Manual 1744085

TeSys U Communication Variables - User’s Manual 1744082

LUB/LUS TeSys U Starters - Instruction Sheet 1629984
1672607 03/2010



1672607 03/2010
1

Introduction

1672607   02/2010
Introduction 
What's in this Chapter?

This chapter contains the following topics:

Presentation of the Application

Introduction

The application example helps you to define Direct On Line (D.O.L.) motor starters step by step, in order to: 

 provide thermal magnetic protection,

 control the motor, and

 obtain contactor feedback and circuit breaker trip feedback.

Description of the Application

 Motor 1 (M1):

3-phase motor, class 10, 5.5 kW (7.5 hp) at 440 V, 50 Hz, rated current In = 10.5 A, D.O.L. 

 Motor 2 (M2):

3-phase motor, class 20, 7.5 kW  (10 hp) at 440 V, 50 Hz, rated current In = 14.7 A, D.O.L. with remote 

monitoring of motor load.

Traditional Solution

The scheme below shows wiring in the traditional solution: all control and feedback information is wired 

through a PLC.

Topic Page

Presentation of the Application 5

The Tesys U Motor Starter Solution on DeviceNet with Allen-Bradley PLC 6

Power Scheme Control Scheme
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Q1 Q2
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Introduction
The Tesys U Motor Starter Solution on DeviceNet with Allen-Bradley PLC

Power and Control Schemes in the Tesys U Motor Starter Solution

Control Units Used in the TeSys U Motor Starter Solution

The solution presented in this Quick Start Guide uses TeSys U to meet different client needs.

 LUCA12BL is a standard control unit used with motor 1 for basic needs:

 control a motor remotely (start/stop)

 provide status information (ready, running, fault condition)

 LUCD18BL is an advanced control unit used with motor 2 for advanced needs, in addition to the 

standard ones:

 warning

 automatic and remote reset via the bus

 indication of the motor load

 differentiation of faults

Power Scheme Control Scheme

1. Allen-Bradley PLC with DeviceNet master scanner

2. ADBL8REM24030 power supply

3. Allen-Bradley DeviceNet yellow cable

4. LU9BN11L prewired coil connection

A
1

A
2

LUCAppBL

5.5 kW

Q1
KM1

M1

440 V 50 Hz

TeSys U TeSys U

A
1

A
2

A
1

A
2

A
1

A
2

LUCDppBL

LULC09

DeviceNet
bus
24 Vdc

DeviceNet
bus
24 Vdc

LULC09

7.5 kW

Q2
KM2

M2

24 Vdc 24 Vdc

LUCDppLUCApp

LULC09 LULC09

TeSys UTeSys U

1

42 3 4

24 V DC
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Introduction
Architecture of the TeSys U System

The following architecture presents the main components of the TeSys U system mounted on a plate:

Legend Commercial Reference Description

1 ABL8REM24030 Regulated switch mode power supply 100...240 V AC, 24 V DC/3 A

2 to 9 Allen-Bradley Programmable Logic Controller (PLC) from Rockwell 

Automation

2 1756-A4 Allen-Bradley ControlLogix chassis with 4 slots

3 1756-PA72 Allen-Bradley ControlLogix power supply 120...240 V AC (5 V/10 A)

4 1756-L61 Allen-Bradley ControlLogix Logix5561 controller, revision 13

5 1756-CP3 Communication port to connect the programmer cable RS232 for processor 

to the computer

6 1787-PLUG10R 10-pin linear plug used for making a thin cable daisy-chain segment

7 1756-DNB Allen-Bradley ControlLogix DeviceNet master scanner: network card for the 

PLC to exchange information between TeSys U and the PLC

8 1485T-P2T5-T5C Allen-Bradley PowerTap for DeviceNet network, 6 A maximum total current

9 1485C-P1-C•• Allen-Bradley DeviceNet yellow, thin cable to be cut according to network 

size

10 LUB12 TeSys U power base

11 LUCA12BL Standard control unit

12, 15 LULC09 DeviceNet communication module with plug-in terminal block, for wire-to-

wire control of A1/A2 terminals

13 LUB32 TeSys U power base

14 LUCD18BL Advanced control unit

16 LU9BN11L Prewired coil connection (optional), or

17 Standard connection 

supplied with LULC09

Plug-in terminal block, for wire-to-wire control of A1/A2 terminals

17

16

1 43 10 112 6 87 14139 12 155
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Introduction
Software Tools

The following software tools must be used to set the applications. Their use requires a basic knowledge.

Fieldbus Network

Protocol: DeviceNet. The DeviceNet network must be terminated at each end with 121 Ω resistors. Each 

line termination must be connected between pins 2 and 4 on the DeviceNet bus connector, that is to say 

between the CAN_H and CAN_L signals. 

In the application example, the line terminators are located on the following devices:

  The DeviceNet master scanner of the Allen-Bradley PLC.

  The LULC09 Devicenet communication module of the advanced TeSys U for motor 2.

Baud Rate: 125 kbps

Address Settings:

 0 for PLC DeviceNet master

 1 for TeSys U DeviceNet motor 1

 2 for TeSys U DeviceNet motor 2

Fallback Strategy Configuration for the TeSys U on the DeviceNet Network

In case of a communication loss with the PLC, the fallback strategy offers the possibility to operate a 

motor in different ways. Set parameter 682 to one of the following values:

The fallback strategy adapted to the application is:

 Value 1 = Freeze outputs for motor 1

 Value 2 = Force stop for motor 2

Commercial Reference Freeware Description

9355-WAB — RSLinx software for linking the PC and the 

Allen-Bradley PLC, and for browsing a DeviceNet 

network.

9357-DNET — RSNetWorx for DeviceNet application for 

configuring and monitoring DeviceNet networks 

and configuring connected devices.

9324-RLD3FR — RSLogix 5000 configuring and programming 

software for the Allen-Bradley Logix5000 familly 

of controller.

— EDS files 1.6 for LULC09 including:

 DN_TESYSU_Sc_St_1.6E.eds
 DN_TESYSU_Sc_Ad_1.6E.eds

Electronic data sheet (EDS) file used by 

RSNetWorx for DeviceNet software to handle the 

devices properly. Download the .eds file from the 

www.schneider-electric.com website.

Value Fallback Mode Description

0 Ignore No strategy is applied. This is not recommended.

1 Freeze outputs On detection of a communication loss, the motor will keep its status:

 If running, the motor will keep running.

 If stopped, the motor will remain stopped.

No change in control status is authorized. A new control will be considered 

only after a communication loss reset (703.3).

2 Force stop (default value) The motor is forced to stop.

Output OA1 = 0

Output OA3 = 0

3 Continue Changes in control status are authorized. A new control will be considered 

even before a communication loss reset (703.3).

4 Force forward Output OA1 = 1 (direct) 

Output OA3 = 0

5 Force reverse Output OA1 = 0

Output OA3 = 1 (reversing)
8 1672607 03/2010
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Setting Up TeSys U
What's in this Chapter?

This chapter contains the following topics:

LUCA12BL and LUCD18BL Settings

Setting Current on the Control Units

The figure below shows how to set current on the control unit using a screwdriver (LUCA12BL here):

Current Setting Values

The table below shows the settings for LUCA12BL (Standard Control Unit) and LUCD18BL (Advanced 

Control Unit):

Topic Page

LUCA12BL and LUCD18BL Settings 9

LULC09 Connectors, Baud Rate, Address Settings 10

4.00A

LUCA / LUCD

LULC09

5.00A

7.00A

9.00A

12.0A

3.00A

TeSys

LUCA 12BL

24V c

CLASS 10

3 a

Control Unit Motor Current Setting Range Motor Nominal Power Current Setting Value = 

Motor Rated Current

LUCA12BL M1 3...12 A 5.5 kW (7.5 hp) 10.5 A

LUCD18BL M2 4.4...18 A 7.5 kW (10 hp) 14.7 A
9



Setting up TeSys U
LULC09 Connectors, Baud Rate, Address Settings

Presentation

Use the DIP switches located on the under side of the LULC09 communication module, to set the 

DeviceNet baud rate and address.

1 DeviceNet bus connector

2 Input/Output terminal block and 24 V DC

3 Unused switches (SW9 and SW10)

4 Baud rate switches (SW7 and SW8)

5 Address switches (SW1 to SW6)

Baud Rate

Assign a baud rate (125, 250, or 500 kbps) using the switches SW7 and SW8. 

In the application, baud rate is 125 kbps:

Address

Assign an address from 0 to 63 (default address), using the 6 right-most switches (SW1 to SW6).

In the application, addresses are 1 and 2:

53 421

24V c

LO1LI1LI2

SW1

SW10

V-
   C

A
N

_L
   S

   C
A

N
_H

   V
+ 

SW8 SW7 Baud Rate

0 0 125 kbps (default value)

SW8 SW7

on

off

SW6 SW5 SW4 SW3 SW2 SW1 Address

0 0 0 0 0 1 1

0 0 0 0 1 0 2

Address 1 for TeSys U Motor 1 Address 2 for TeSys U Motor 2

SW6 SW5 SW4 SW3 SW2 SW1

on

off

SW6 SW5 SW4 SW3 SW2 SW1

on

off
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Setting Up Communication Network to a PLC
Configuring TeSys U on the DeviceNet Network with RSNetWorx for DeviceNet and RSLogix 5000

Introduction

This chapter describes step by step how to set the DeviceNet communication including the TeSys U 

motors starters and an Allen-Bradley PLC using:

 RSNetWorx for DeviceNet configuration software for network configuration, and

 RSLogix 5000 for PLC configuration.

Prerequisite

Before you start configuring the application, RSLinx, RSNetWorx for DeviceNet, and RSLogix 5000 

software from Rockwell Automation must be

 correctly installed on your computer,

 activated, and

 correctly configured to communicate with the PLC.

Configuration Process
11



Setting Up Communication Network to a PLC
1) Downloading the EDS Files

The following table describes the steps to follow to download the EDS files associated with Tesys U from 

the www.schneider-electric.com website:

The table below gives the associations between the 2 TeSys U variants and the associated EDS file 

names.

 The letters Sc stand for Starter-Controller.

 The letters St and Ad stand for Standard and Advanced control unit, respectively.

 The letter R stands for Remote configuration.

2) Registering the EDS Files using RSNetWorx for DeviceNet

To register the starter-controllers’ EDS in the EDS library of RSNetWorx for DeviceNet software, follow 

the procedure below:

Step Action

1 Open the Schneider Electric website: www.schneider-electric.com.

2 Type TeSys U in the Search field.

3 In the Product Ranges section, click TeSys U.

4 Click the Downloads tab, and then Software/Firmware.

5 Select EDS Files 1.6 for LULC09 and download the eds_1_6.7z file on your hard disk.

6 Extract the eds_1_6.7z file into a single directory to your hard disk.

It contains the 2 EDS files corresponding to the 2 TeSys U used in the application example:

 DN_TESYSU_Sc_St_1.6E.eds file

 DN_TESYSU_Sc_Ad_1.6E.eds file

Variants Names EDS File Names Motors (for the Application)

TeSysU Sc St R DN_TESYSU_Sc_St_1.6E.eds Motor 1

TeSysU Sc Ad R DN_TESYSU_Sc_Ad_1.6E.eds Motor 2

Step Action Result

1 Start RSNetWorx for DeviceNet.

2 Select the menu command Tools → EDS Wizard... The Wizard welcome screen opens.

3 Click Next. The Options screen opens.

4 Select Register an EDS file(s) and click Next. The Registration screen opens.

5 Select Register a directory of EDS files and 

browse to the directory in which you unzipped the 

EDS files.

6 Click Next. The EDS File Installation Test Results screen 

opens.

7 Click Next. The Change Graphic Image screen opens. The 

2 TeSys U are listed in the Product Types field as 

motor starters.

8 Click Next. The Final Task Summary screen opens.

9 Verify that the devices have been registered and 

click Next.

The completion screen opens.

10 Click Finish. The EDS Wizard closes. 

You can find the EDS recorded into the hardware 

library under DeviceNet → Vendor → 

Schneider Automation, Inc. → Motor Starter
12 1672607 03/2010



Setting Up Communication Network to a PLC
3) Viewing the Devices on the DeviceNet Network in Online Mode using RSNetWorx for DeviceNet

The process for viewing the devices on the DeviceNet network in online mode using RSNetWorx for 

DeviceNet software is described below: 

Step Action

1 Connect the appropriate programming cable from your PC to the Allen-Bradley PLC. 

2 Connect each device to the network. 

3 From RSNetWorx for DeviceNet software, select the menu command Network → Online.

Result: The Browse for network dialog box opens.

4 Set the communication path based on the system and application requirements by browsing the network 

to DeviceNet, and then click OK.

5 Click OK in the dialog box which displays the parameters of the devices that are not going to be read or 

changed. 

Result: When the Browsing network screen finishes, the physically connected devices appear in the 

configuration view including the standard TeSys U TeSysU Sc St R and the advanced TeSys U 

TeSysU Sc Ad R. The node addresses appear below each icon.

6 Check the node address and baud rate of the TeSYs U starter-controllers by selecting the menu 

command Tools → Node Commissioning.

Result: The Node Commissioning dialog box opens.

7 Click on the Browse button.

Result: The Device Selection dialog box opens.

8 Browse to the scanner, and then click on OK.
1672607 03/2010 13



Setting Up Communication Network to a PLC
4) Setting Parameters to the 2 TeSys U using RSNetWorx for DeviceNet

The process for setting parameters to each TeSys U using RSNetWorx for DeviceNet software is 

described below:

9 The Node Commissioning dialog box opens with the current settings for the device.

If necessary, set the correct speed under New Device Settings, then click on Apply, and then click on 

Exit to close the dialog box.

Step Action

Step Action

1 From the configuration view, double-click a TeSys U starter-controller icon.

2 In the starter-controller configuration dialog box, click the Parameters tab.

3 Agree to upload the configuration from the device before going online by clicking Upload in the dialog 

box.

4 Select the Groups check box.

5 Select the Setting group to access starter-controller setting parameters.
14 1672607 03/2010



Setting Up Communication Network to a PLC
5) Configuring the DeviceNet Scanner using RSNetWorx for DeviceNet

The process for configuring the scanner to communicate with the TeSys U starter-controllers is described 

below. The procedure involves adding the TeSys U to the scanlist of the master scanner using 

RSNetWorx for DeviceNet software:

6 Configure the communication loss fallback strategy:

 For TeSysU Sc St R:

 Set the communication loss fallback strategy to Freeze outputs.

 Click Apply.

 For TeSysU Sc Ad R, keep the default communication loss fallback strategy: Force stop.

 Agree to download the configuration to the device when prompted in the dialog box.

7 Select the DeviceNet interface group.

8 Select the data you want to exchange (Instance):

 Set PollProdPath parameter to instance 110-Tesys U Monitoring registers (with dynamic 

configuration)

PollProdPath consists of input assembly object produced by the TeSys U starter-controller on polling 

sent by the scanner.

 Set PollConsPath parameter to instance 100-Tesys U control registers

PollConsPath consists of output assembly data sent by polling by the scanner and consumed by the 

TeSys U starter-controller.

 Set CCProdPath parameter to instance 110-Tesys U Monitoring registers

CCProdPath consists of data produced by the TeSys U starter-controller on Change-of-state (COS) 

or Cyclic data exchanges.

 Click Apply to apply the changes.

 Agree to download the configuration to the device when prompted in the dialog box.

9 Click OK to close the dialog box corresponding to the TeSys U starter-controller for which you have 

changed the parameters.

10 Go back to step 1 and repeat the procedure for the second TeSys U.

Step Action

Step Action

1 Go offline by selecting the menu command Network → Offline.

2 From the configuration view, double-click the icon of 1756-DNB scanner.

Result: The scanner configuration dialog box opens.

3 Click the Scanlist tab.

4 Check Automap on Add to enable the software to automatically assign the memory locations for each 

device.
1672607 03/2010 15



Setting Up Communication Network to a PLC
5 In the Scanlist tab, highlight the 2 starter-controllers in the Available Devices list, and click the right-

pointing double chevron >> to add all the devices at once to the scanlist.

Result: The 2 starter-controllers now appear in the Scanlist.

6 Edit the input/output parameters of each TeSys U by selecting the corresponding label under Scanlist, 

and then by clicking the Edit I/O Parameters button.

Result: The Edit I/O Parameters dialog box opens.

7 Select the type of data exchange by checking Polled.

8 Under Polled, enter the input and output sizes in bytes which depend on the selected instances for the 

DeviceNet Interface object and the TeSys U variant:

 For TeSysU Sc St R:

 Enter 4 in the Input Size text field.

 Enter 6 in the Output Size text field.

 For TeSysU Sc Ad R:

 Enter 6 in the Input Size text field.

 Enter 6 in the Output Size text field.

9 Click OK.

Result: The Edit I/O Parameters dialog box related to the TeSys U for which you have changed the 

parameters closes.

10 In the scanner configuration dialog box, click the Download to scanner button.

The Downloading Scanlist to Scanner dialog box opens.

11 Click Download.

Step Action
16 1672607 03/2010



Setting Up Communication Network to a PLC
12 In the scanner properties dialog box, click the Input tab: the device mapping appears in the lower panel 

which enables to determine the tag name (address) for DeviceNet data.

Select Node 01, TeSysU Sc St R or node 02, TeSysU Sc Ad R to see the corresponding data 

highlighted in blue in the input array.

NOTE: Refer to the user’s manuals TeSys U LULC09 DeviceNet Communication Module and TeSys 
U Communication Variables for details of which registers are used with the TeSys U depending on the 

instance.

For example: In the application, the instance 110 has 6 bytes (3 words) for reading the following 

registers depending on the TeSys U system:

 For the standard and advanced TeSys U:

 Register 455 (TeSys U Status)

 Register 458 (I/O Module status)

 For the advanced TeSys U:

 Register 461 (Warning register)

The table below shows the byte arrangement of I/O messages for the 2 TeSys U, when input assembly 

is Instance 110:

NOTE: The 1756-DNB module is installed in slot 1 in the ControlLogix chassis. Therefore, the 

addresses for the inputs and outputs of the TeSys U starter-controllers begin with Local:1.

13 Click the Output tab: an entry for the device appears in the output array.

Select Node 01, TeSysU Sc St R or node 02, TeSysU Sc Ad R to see the corresponding data 

highlighted in blue in the output array.

For example: In the application, the instance 100 has 6 bytes (3 words) for writing the following registers 

in the standard and advanced TeSys U systems:

 704 (TeSys U command)

 703 (reset communication loss)

 700 (other control command)

The table below shows the byte arrangement of I/O messages for the 2 TeSys U, when output assembly 

is Instance 100:

14 Select the menu command Files → Save as to save the global configuration to the PC as a .dnt file 

(DeviceNet file): DNnetwork.dnt in our application example.

15 Select the menu command Network → Download To Network.

16 Agree to download the device configuration to the network.

Step Action
1672607 03/2010 17



Setting Up Communication Network to a PLC
6) Configuring the PLC using RSLogix 5000

The process for configuring the PLC using RSLogix 5000 software is described below:

Step Action

1 Start RSLogix 5000 software.

2 Create a project by selecting the command File → New.

Result: The New Controller dialog box opens.

3 Set the characteristics of the controller used in the application example:

 Type: 1756-L61 Controller ControlLogix5561

 Revision: 13

 Name: Enter a controller name, for example TeSysU_application. The name will be used to create 

the project file; the .acd extension is automatically appended to this name.

 Chassis Type: 1756-A4 4-Slot ControlLogix Chassis

 Slot: 0, which is the slot number for this controller.

NOTE: In ControlLogix, controllers occupy a numbered slot in the chassis and can be placed in any slot. 

It is also possible to place multiple controllers in the same chassis.

 Create in: Enter the directory in which you want to store the project file.

4 Confirm the selected settings and create the project by clicking OK.

5 In the standard toolbar, click the Path button.

Result: The Select Recent Communications Path dialog box opens, from which you can choose a 

communications path from among the most recent paths stored on the PC.

6 Select the controller, and then click the Go online button.

7 Configure the 1756-DNB scanner module as an I/O device for the application example:

In the Controller Organizer, expand the tree structure to I/O Configuration → [1] 1756-

DNB ScanDevicenet, and then double-click the scanner’s label.

Result: The Module Properties dialog box opens.

8 Select the RSNetWorx tab, and then browse to the configuration file for the network that you saved 

before: DNnetwork.dnt.

9 Click OK to close the module properties dialog box.
18 1672607 03/2010



Setting Up Communication Network to a PLC
7) Transferring the Configuration to the PLC using RSLogix 5000

The process for monitoring the controller’s tags and values assigned to them using RSLogix 5000 

software is described below:

Step Action

1 Turn the key located on the front of the PLC processor to the PROG position. 

2 In RSLogix 5000 software, set the operational mode to Offline.

3 Select the menu command Communications → Download.

Result: The Download dialog box opens.

4 Confirm the download by clicking button Download when prompted in the dialog box.

Result: A message indicates that the download is complete, in the results window at bottom of the 

screen.

5 Switch the controller to Run mode: turn the key to the RUN position on the front of the PLC processor. 

The RUN LED of the PLC processor turns green on and the program is launched.

6 In the RSLogix 5000 Controller Organizer, select Controller Controller_1756 → Controller Tags, and 

then right-click Monitor Tags.

Result: The Controller Tags window appears.

7 Select the Monitor Tags tab at the bottom of the Controller Tags window.

8 Activate the internal bit of the DeviceNet card to put the DeviceNet network in Run mode:

Expand the tag name Local:1:O → Local:1:O.CommandRegister → 

Local:1:O.CommandRegister.Run, and then replace the value 0 (scanner in idle mode) by 1 (scanner 

in Run mode).

Communication is established correctly when the LEDs on the modules display the following behavior:

 LULC09 communication modules:

 MNS (module/network status) is steady green.

 24V  lights up green.

 DeviceNet scanner module:

 MOD/NET (module/network) lights up green.

 I/O lights up green.
1672607 03/2010 19



Setting Up Communication Network to a PLC
8) Performing Functional Testing of the Communication Network Including Allen-Bradley PLC and TeSys U Products

Test the communication network from the Controller Tag window using RSLogix 5000 software as 

described below:

Step Action

1 Expand the tag name Local:1:I.Data to view the values assigned to the tags.

2 Name the topological addresses in such a way to avoid programming with names which do not provide 

any information of the contents of the memory location. Refer to the user’s manuals TeSys U LULC09 
DeviceNet Communication Module and TeSys U Communication Variables for details.

In the application example, the following tags names are used for Motor 1 (standard TeSys U):

3 Monitor the tags for Motor 1 and Motor 2 corresponding to the standard and advanced TeSys U, 

respectively.

For example: Test the control of the standard TeSys U with the Input command Local:1:I.Data[0] 

(Register 455):

 Bit 0 corresponds to the Ready status: the TeSys U product is ready to operate on command request.

 In our application, the rotary handle is turned to ‘On’ position and there is no fault (register 451 = 0). 

The bit value is set to 1.

 Turn the rotary handle to ‘Off’ position (0 on the TeSys U front).

 The value 1 change to 0.
20 1672607 03/2010
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